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Thesis & Graduation Instructions 
for M.S. Students (Thesis Option) 

 
This information packet has 3 important components: 

1) Timeline for Final Oral Exam / Thesis Defense 

2) Master’s Thesis Requirements (instructions regarding format, sample pages, etc.) 

3) Procedures after the Final Oral Exam (including instructions on electronic submission of 
your thesis and documentation that must be submitted to the Graduate Studies Office) 

Please use the checklist below to ensure that you have completed all of the steps 
required to graduate. 

1) Ensure that your final oral examination committee has electronically reported the results 
in Seguidor, within 7 days after completion of the examination 

2) Report on Master’s Degree Form 

3) Convocation & Accomplishments Survey Certificate of Completion 

4) Graduate Program Effectiveness & Student Satisfaction Survey Certificate of Completion 

5) Media Authorization Form 

6) Electronic submission of your final thesis to the DigitalCommons@UNMC 

Please refer to page 12 of this document for additional information about the steps listed above, 
including links to the surveys.  

The Report on Master’s Degree & Media Authorization forms are located on pages 15 & 16 of this 
document.  

* Once you have completed all of the above steps, combine the documents outlined in steps 2-5 in to 
one single PDF and email the single PDF to the Graduate Studies Office 
(unmcgraduatestudies@unmc.edu) for one single submission. The Office of Graduate Studies will not 
accept the requirements document by document.   
 

https://net.unmc.edu/seguidor/index.php
mailto:unmcgraduatestudies@unmc.edu
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Thesis-Option M.S. Students:  
TIMELINE FOR FINAL ORAL EXAM / Thesis Defense 

• Prior to February 10th (for May graduation), June 10th (for August graduation) or October 10th (for December 
graduation): Complete the degree application on MyRecords. 

• Recommended:  Two-to-three months in advance of the approximate date of the Final Oral Exam, the student should 
consult with his/her Advisor and Advisory Committee and establish the tentative (unofficial) date and time for the 
exam. It is also advisable at this point to reserve the rooms in which the public and closed-door components of the 
exam will be held. Note that the Final Oral Exam must occur at least 1 week after completing the Comprehensive 
Exam and at least 2 weeks before commencement (graduation). 

• At least 4 weeks before the tentative date of the Final Oral Exam (at least 6 weeks before commencement), the 
thesis must be presented to the Advisor, who must determine if it is of sufficient merit (based on scientific criteria) 
and in a fit condition (based on formatting and writing quality) to warrant holding the Final Oral Exam. The student 
is responsible for ensuring that the thesis is properly formatted (see MASTER’S THESIS REQUIREMENTS) and 
has been thoroughly checked for errors in terminology, grammar and spelling prior to presenting the document to the 
Advisor. The Advisor may provide feedback to aid the student in revising the document, if necessary. However, 
because the student is not eligible for the Final Oral Exam until the thesis is completed and approved by the Advisor, 
any revisions to the thesis required by the Advisor must be completed at least 2 weeks before the Final Oral Exam.  

• At least 2 weeks before the Final Oral Exam (at least 4 weeks before commencement):  
o The Advisor-approved thesis must be presented to members of the Advisory Committee.  
o With approval from the Advisor, the student must (via Seguidor™) establish the Examining Committee and 

officially schedule the Final Oral Exam. The Advisory Committee must agree to the date & time before this 
information is entered into Seguidor. The exam location must also be established at this time.  Advance planning 
is necessary, because Seguidor will not allow exam scheduling within 2 weeks of the desired exam date. The 
exam may be scheduled more than 2 weeks in advance, but only if the Advisor has been given least 2 weeks to 
make a judgment regarding the condition of the thesis (see above). 
 All members of the student’s Advisory Committee should serve on the Examining Committee.  
 At least 1 NU Graduate Faculty member of the Advisory Committee must be present for the Final Oral 

Exam, otherwise the exam must be rescheduled. 
o If the thesis includes any published materials, the student is advised to request at this time permission to include 

them in the thesis (see MASTER’S THESIS REQUIREMENTS, page 2).   

• At least 2 weeks before commencement:  Final Oral Exam.  It is recommend that you complete the Report on 
Master’s Degree (see final page of the M.S. Thesis and Graduation Instructions) and have it available for your 
Advisory Committee to sign immediately following the exam (prior to leaving the exam room). 

• No more than 7 days after the Final Oral Exam: Results of the Final Oral Exam must be reported to the Graduate 
Studies Office (via Seguidor). It is recommended that the Examining Committee complete this task immediately 
following the exam (prior to leaving the exam room). 

• At least 7 days before commencement: All required graduation documentation must be submitted to the Graduate 
Studies Office, and the thesis must be submitted electronically to the McGoogan Library for publication via the 
DigitalCommons@UNMC (see PROCEDURES AFTER THE FINAL ORAL EXAM).  

https://myrecords.nebraska.edu/psp/myrecords/NBM/HRMS/?cmd=login
https://net.unmc.edu/seguidor/index.php
https://net.unmc.edu/seguidor/index.php
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MASTER’S THESIS REQUIREMENTS 

A - GENERAL REQUIREMENTS 
 The master’s thesis is a written document required by universities for the completion of the Master of Science 
(M.S.) or Master of Arts (M.A.) degree. The purpose of the thesis at UNMC is to provide written documentation of 
the research achievements of the student, thereby supporting awarding of the M.S. degree by the University of 
Nebraska.  

 The thesis should be a complete and independent document that can be understood without reference to other 
materials.  It should present original research on a defined problem – research for which the student has taken major 
responsibility. Therefore, the research should be primarily the student’s work, although others may have contributed 
in a minor way. The thesis should reveal a capacity to carry on independent study or research and should 
demonstrate the student’s ability to use the techniques employed in the field of investigation.   

B - FORMAT 
• Margin Settings:  Left = 1.5";  Right = 1";  Top = 1";  Bottom = 1" 

 Figures and tables must fit within the same margins as the text. If oversized figures or tables are 
included, they should have exactly the same margins as the text, or should be folded as needed to be 
contained within those margins. 

• Fonts:  
 The same font must be used in all elements of the document – including all text, page numbers, 

headings, subheadings, tables, figure legends, etc. 
 The main text font size must be a minimum of 10 pt; however, 11 pt is recommended.  
 Recommended fonts for the main text: 11 pt Arial, 11 pt Helvetica, 11 pt Calibri, 11 pt Minion Pro 

Med, 11 pt Palatino Linotype, or 11 pt Times New Roman.     
 Headings and subheadings may be in a larger font size, and may be in bold print, but the font must be 

the same as the one used in the remainder of the document. Consistency is necessary. If a large type is 
used for one subheading, the same size must be used in all subheadings of the same level. If the major 
headings and subheadings have two different font sizes, the larger font must be used in the major 
headings.  

• Line spacing:  The document must be double spaced (except figure legends, long headings/subheadings, and 
footnotes).   

• Paragraph settings:  Paragraphs should be preceded by a spacing of 6 pt, and should begin with a Tab of 0.25" 
or 0.5" (do not indent the first line of a paragraph using the space bar). Paragraphs should be either left-aligned 
or justified (text aligned along both the left and right margins). Be sure to use the same paragraph settings for 
the entire body of the document. These paragraph setting constraints do not apply to headings and subheadings, 
which generally should be preceded by a spacing of 12 pt (or more) and may be either centered between the 
margins (major headings) or left-aligned (subheadings). 

• Hyphenation should be employed to avoid unsightly gaps between words when using justified paragraphs 
(optional for left-aligned paragraphs). Words of less than 6 letters should not be divided by a hyphen at the end 
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of a line. Divided words should not occur at the end of more than two consecutive lines or on the final line at the 
bottom of a page. 

• Material contained in published manuscripts must be reformatted to thesis specifications. Reprints of published 
material are not permitted in the thesis.  If you include material (text, figures, etc.) from previously published 
work, you must obtain permission from the publisher and you will need to upload proof of the publisher’s 
permission when submitting the thesis to the DigitalCommons@UNMC (see page 6).  

Note: Journals are routinely asked for permission to include published materials in student theses. The process 
for obtaining such permission is usually included in the journal’s Instructions for Authors. 

• Footnotes should be single spaced and should be placed at the bottom of the page to which they pertain unless 
special instructions are provided by the department/program. 

• Page numbers must appear in the header at the top right of each page (except the Title Page and Abstract). The 
page number may be 9 or 10 pt font, with the Header Position set at 0.5" from the Top and aligned with the right 
margin. Be sure to use the same font as the main text. Pages before the Introduction should be numbered with 
small Roman numerals (i, ii, iii, iv, etc.). Beginning with the Introduction, number all pages through the 
remainder of the document using Arabic numbers (1, 2, 3, etc.). Steps for accomplishing this page numbering 
layout in Microsoft Word 2010: 

 To insert small Roman numeral page numbers for the initial portion of the document: With the cursor on the 2nd 
page of the document (not the title page), click on the Insert tab  Page Number  Top of Page  Choose the 
option showing the number positioned at right margin.  In the Options section of the Design / Header & Footer 
Tools Tab, be sure that Different First Page is selected. Click on Page Number   Format Page Numbers select 
i, ii, iii,… in the Number Format pulldown menu.  In the same Format Page Numbers window, ensure that the 
Page numbering Starts at i.  Click on OK. 

 To utilize Arabic page numbers beginning with the Introduction: Position the cursor at the bottom of the page 
immediately preceding the Introduction. Click on the Page Layout Tab  Breaks  Section Breaks: Next Page. 
Then, click on the Insert Tab  Page Number  Top of Page  Choose the option showing the number 
positioned at right margin.  In the Options section of the Design / Header & Footer Tools Tab, unselect Different 
First Page and unselect Link to Previous. Click on Page Number  Format Page Numbers  select 1, 2, 3,… in 
the Number Format pulldown menu. In the same Format Page Numbers window, ensure that the Page numbering 
starts at 1.  Click on OK. 

 Unless you are very skilled with the section break and page numbering functions in your word processor, use a 
white shape (rectangle or circle; with no border) to obscure page numbers on the Title Page and Abstract pages.   

• Figures and tables are generally presented one per page, although multipanel figures are allowed. Each figure 
should be numbered consecutively and have a legend that begins with the title/caption (“Figure 1: Giant spiral 
galaxy” in the example below) and includes all of the information needed to interpret the figure. The legend may 
appear on the page preceding the figure, or on the same page as the figure, being sure to use the same approach 
throughout the document. Each figure (with its accompanying legend) should appear in the document in close 
proximity to, but not before, the first referral to the figure in the text. The figures and legends should not be 
clustered at the end of the Thesis. The student should consult with his/her Advisor to determine the preferred 
format.  

Useful tip: For ease of editing the document and correct positioning the figures, 
do not insert figures and legends into the document until you have a complete draft 
of the entire thesis. 

Some departments/programs may prefer that figures be integrated within the 
main body of text, similar to the appearance of journals or magazines (see 
example shown here). Useful tips for implementing this specific approach are 
provided below: 

 Both the figure and its accompanying legend should be inserted within a single 
text box delineated by a thin black or grey line. (Do not simply draw a rectangle 
around the figure and its legend! Copy/paste the figure into a text box and type 
the legend within the same text box.) This will vastly facilitate editing of the 

 
Figure 1: Giant spiral galaxy. This 
image taken with the Hubble Space 
Telescope Wide Field and Planetary 
Camera shows galaxy M101, which is 
estimated to contain at least 1 trillion 
stars (previously published in ref. 89). 
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document and the positioning of the figure and its legend on the page – you will only need to position the text 
box, because both the figure and the legend are contained within the textbox.  

 When using this approach, the figure legend may be 1- or 2-pt smaller font size than that used for the main body 
of text.  

 For most relatively small figures (such as the example shown here), format the text box (right click  More 
Layout Options) as follows:  Text Wrapping  Wrapping Style = Square; Position  Horizontal alignment = 
Right relative to Margin. Do not select the Move Object with Text option, otherwise your text box will tend to 
“jump around” (move from page to page, or even disappear) as you edit the document! 

 If the table or figure spans most of the width of the page within the confines of the margins, format the text box 
(right click  More Layout Options) as follows:  Text Wrapping  Wrapping Style = Top and bottom; Position 
 Horizontal alignment = Center relative to Margin. Do not select the Move Object with Text option. 

 Once you have inserted the figures, display and editing of the document is most efficient if you activate “show 
picture placeholders” (Microsoft Word 2010:  Select Customize Quick Access Toolbar → More Commands → 
Advanced → under Show document content, select Show picture placeholders.  To view the figures as they will 
appear in the document, unselect this option.) 

Similar criteria (and useful tips) apply to positioning of tables in the thesis document. For example, tables must 
be numbered consecutively (Table 1, Table 2, etc.), include legends with titles/captions, and may appear on a 
dedicated page or in boxes within the body of text. Regardless of the figure/table presentation mode chosen by 
the student, the legend for any previously published figure or table must include the appropriate literature 
citation. 

• Literature Citations. The student is strongly advised to utilize citation/bibliography software (e.g. EndNote, 
Reference Manager, or RefWorks) for incorporating literature citations into the thesis and for generating the 
Bibliography. The style of in-text citations should be chosen based on consultation with the Advisor. 

C - ORGANIZATION & CONTENT 
 The thesis may contain some, or all, of the elements listed below. Those elements that are contained in the 
document must appear in the order listed and must be formatted as described. Each element should begin on a new 
page. Required items are indicated by the checkmark (). 

 Title Page: Must be formatted and worded according to the sample attached (with some variation allowed for 
use of larger font size for the title and the student’s name). Do not number this page. 

Acknowledgments:  You may acknowledge those who assisted you during your graduate studies.  

 Abstract:  The abstract is limited to 250 words including the title and must be typed in a format according to the 
sample attached. Do not number the pages of the abstract. Utilize the word count feature of a word-processing 
program to ensure that the abstract conforms to the 250-word limit. 

 Table of Contents:  The Table of Contents (sample attached) should provide the reader with an analytical view 
of the materials covered by the study, together with the order of appearance in the document. All headings and 
subheadings listed in the Table of Contents must agree word-for-word with the headings/subheadings appearing in 
the body of the document.  

Useful Tip: The student is advised to spend a few minutes up front learning how to have their word-processing program 
(e.g. Microsoft Word) automatically generate a Table of Contents – this will save hours in the long run. 

List of Figures: If any illustrative or graphic materials are used, a List of Figures must be provided. The figure 
titles/captions included in the list must agree word-for-word with the titles/captions appearing in the body of the 
work. Page numbers must be those on which the legend appears.  

Useful Tip: The List of Figures can be generated automatically in Microsoft Word (which refers to this as inserting a 
Table of Figures) based on captions (figure titles) that you have inserted into the document.  
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List of Tables:  If any tables are included in the thesis, a List of Tables must be provided. Page numbers must be 
those on which the table appears. The List of Tables is can be generated automatically in Microsoft Word though 
the same process used for generating a List of Figures.   

List of Abbreviations: Define each abbreviation used in the document, according to the sample attached.  

 Chapters:  The body of the thesis is composed of Chapters that provide a complete presentation of the project 
in a systematic and organized manner. The Chapters should be numbered (1, 2, 3, etc.), with each Chapter bearing 
a title. Students should consult with their Advisors for guidance in organizing the Chapters and their content. While 
there is considerable flexibility in this regard (which may vary with the field of study), most master’s theses at an 
academic medical center will contain the following Chapters:  

• Chapter 1: Introduction.  This Chapter should present a comprehensive and integrated presentation and critical 
analysis of the literature relating to the overall thesis topic. It should also frame the questions addressed by the 
thesis.  

• Chapter 2: Methods.  This Chapter should include a description of the procedures utilized in the research in 
sufficient detail to indicate that the student has a thorough understanding of the techniques used to answer the 
question and to permit others to replicate the work.   

• Chapter 3: Results.  This Chapter should be a complete presentation of the research findings in a logical and 
clear fashion.  

• Chapter 4: Discussion.  This Chapter should address the results in terms of their importance, their limitations, 
their place in our current knowledge, the conclusions drawn based on the results, and the future directions or 
implications suggested by the results.  

 Bibliography:  This section must provide complete listing of all literature cited in the thesis.  Each citation 
should list all authors (within reason; limit to 20 for reports of large clinical trials, for example), full title of the 
paper, journal name (standard abbreviations used by PubMed are acceptable), volume, range of pages (not simply 
the 1st page), and the publication year. The list may be arranged by order of citation or alphabetically by author, at 
the discretion of the student and his/her Advisor.   

Useful Tip: Do not waste time creating your own bibliography citation format within your reference citation software; 
rather, select one of the options provided by the software. There will be hundreds among which to choose.  

Appendices: May include surveys, ancillary observations, detailed protocols developed for specific procedures, 
recipes for key reagents, etc. If there is more than one appendix, number them A-to-Z, and include a title for each 
appendix (e.g., APPENDIX A: PATIENT CONSENT FORM). 
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UNMC MASTER’S DEGREE PROGRAM NAMES (for use on title page) 

Official names of UNMC Master’s programs, as approved by the Board of Regents: 

• Biochemistry & Molecular Biology Graduate Program 

• Biomedical Informatics Graduate Program 
• Cancer Research Graduate Program 
• Emergency Preparedness Graduate Program 
• Immunology, Pathology & Infectious Disease Graduate Program 
• Medical Anatomy Graduate Program 
• Medical Sciences Interdepartmental Area Graduate Program 
• Molecular Genetics & Cell Biology Graduate Program 
• Pathology & Microbiology Graduate Program 
• Pharmaceutical Sciences Graduate Program 
 
Specializations (MSIA Only): 

• Biological Defense & Health Security 

• Clinically Relevant Basic Research 

• Clinical & Translational Research 

• Clinical & Translational Research Mentored 

Scholars Program 

• Health Practice & Medical Education Research 
• Munroe-Meyer Institute 
• Oral Biology 
• Patient-Oriented Research 
• Physical Therapy  
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by 
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A THESIS 

Presented to the Faculty of 
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for the Degree of Master of Science 
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Graduate Program 
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April, 2015 

Advisory Committee: 
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Official name of your 
graduate program (see 
page 5), single-spaced.  
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Either the month and year of 
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or the month and year of 

graduation. 

Do not number 
the title page! 

Sample TITLE PAGE 

Do not include 
professorial rank 
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or degree. 

 If you have co-advisors, use 
Professors rather than listing 
the title separately for each. 

MSIA graduates only: 
Specialization (see page 5) 

should be indicated, enclosed 
within parentheses.  
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EVALUATION OF NUTRITIONAL METHODOLOGY AND EXPERIMENTAL 
DESIGN IN THE STUDY OF RIBOFLAVIN DEFICIENCY: 

ASSESSMENT OF PHYSICAL AND BIOCHEMICAL LESIONS 

Larry H. Gerthoff, M.S. 

University of Nebraska, 2013 

Advisor: Myron A. Mehlman, M.S. 

The adequacy of some components of conventional methods employed in the study of riboflavin

deficiency was questioned. This thesis attempted to evaluate how several important changes in 

the experimental design affected the response of the albino rat to riboflavin deficiency. This was 

accomplished by analysis of a large variety of criteria including classical physical lesions and 

lesions in biochemical parameters associated with gluconeogenesis. The effect of the following 

experimental variables on the development… 

This must be the year 
of your graduation.

Sample ABSTRACT 
Do not number the 

pages of the abstract 

The abbreviation “M.S.” must follow 
your name on the abstract only. 
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PROCEDURES AFTER THE FINAL ORAL EXAM 

Congratulations on your great accomplishment! 

 Listed below are the steps needed to graduate: 
• Complete the Report on Master’s Degree (PDF form, fillable in Adobe Reader or Adobe Acrobat), print the

form and obtain the appropriate signatures.
Useful Tip: Have the members of your Advisory Committee sign the form at the end of your successful thesis 
defense (before leaving the exam room). 

• Revise the thesis according to the recommendations of your Advisory Committee. Revisions of the abstract and
thesis are normally made by the student in consultation with the PI/Advisor, and are incorporated into the final
versions of the abstract and thesis.

• Meet with your Advisor to discuss placing an embargo on release of your thesis once it is published in UNMC’s
online digital repository (DigitalCommons@UNMC).

• Complete the electronic submission of your final thesis to the DigitalCommons@UNMC, including specifying
the embargo duration.  (For detailed instructions, see PROCEDURES AFTER THE FINAL ORAL EXAM,
pages 2-3).

• Complete the online Convocation & Accomplishments Survey.  You will find it useful to have your CV or
resume handy when completing this survey.

The information collected via this survey provides Graduate Studies with data that are needed for program 
evaluation, accreditation and other reports. It will also facilitate the celebration of your accomplishments at the 
Graduate Studies Convocation Ceremony, as well as allowing us to contact you in the future. 

• Complete the online Graduate Program Effectiveness & Student Satisfaction Survey.
The information collected via this survey will help Graduate Studies improve the education experience for future
students. Please be thoughtful and truthful in completing this survey, and be reassured that the results are completely 
anonymous.  

Once you have completed all of the above steps, combine the following documents in to one single PDF 
and email the single PDF to the Graduate Studies Office (unmcgraduatestudies@unmc.edu): 

• Certificates of Completion for both of the surveys noted above.

• Report on Master’s Degree form.

• Media Authorization form.

The student is solely responsible for ensuring that all of the tasks listed above are completed, including 
submission of the appropriate documents prior to the deadline established by the Graduate Studies Office. 

https://www.surveymonkey.com/r/DBXDVRJ
https://www.surveymonkey.com/r/N6HPFBT
mailto:unmcgraduatestudies@unmc.edu
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ELECTRONIC SUBMISSION THE THESIS

 After making any revisions requested by your Advisory Committee, the final thesis must be submitted 
electronically (as a PDF file) to the McGoogan Library of Medicine for deposition into the UNMC electronic 
repository (DigitalCommons@UNMC). There will be no opportunity for editorial or other changes in the thesis 
after submission to the library. Once submitted, it will be reviewed by library staff before publishing. Before 
submitting, please read all relevant policies and/or submission guidelines. 

The submission process consists of the following steps: 
1. Read and accept the Submission Agreement (provided online at the beginning of the process)
2. Provide information about yourself and any co-authors
3. Upload your electronic file and associated files

Before you begin, please be sure you have the following items: 
• The exact title of your thesis
• The abstract (for ease of submission, you will want to copy/paste the abstract from a Microsoft Word

document into the online abstract submission box)
• A list of keywords
• A PDF file of your work
• Electronic copies of copyright permissions (to be uploaded as Additional Files)

Embargoes & Restrictions 

What is an embargo?  An embargo is a delayed release of information.  Consult with your Advisor about whether 
or not you require an embargo and the appropriate length of the embargo (6 months, 1 year, or 2 years). By default, 
a 6-month embargo will be applied. You will have an opportunity to establish a different embargo duration when 
uploading your thesis. Your thesis will not be available to download from the DigitalCommons@UNMC until the 
embargo has expired. The embargo begins the date of submission, not the date of online publication. If you choose 
not to embargo your work, it will be immediately available to the public. 

Why would you want to embargo your thesis?  Some reasons to request an embargo include: 
• There may be patentable rights or sensitive data in the work.
• There is an ethical need to prevent disclosure of sensitive information about persons, institutions, etc.
• You may plan to submit portions of the work for publication in a journal.
• Your Advisor may plan to use some of the results as preliminary data for a grant.

Submission Instructions 
1. Once you have completed your manuscript and are ready to electronically submit it to

DigitalCommons@UNMC, go to http://digitalcommons.unmc.edu/etd/ and click on the Submit Your Work
link, located on the lower right hand menu bar.

2. You will be asked to login or create an account. Most graduates will need to Create new account. In order
for you to receive monthly usage reports, please use your permanent email address.

3. Before proceeding, you must check your email to confirm your account.
4. Once confirmed, you will be directed to the Submission Agreement. Please read the agreement and accept

the terms.
5. You will now see a form in which you must enter all of the required information – title, keywords, Advisor(s),

abstract, etc.  Note that the Date of Award should be the date on which your degree will be conferred
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7. Upload Additional Files associated with your thesis, including documentation that you have permission to 
use any copyrighted materials and materials that have already been published (i.e. in a journal article). This is 
also the point at which you can upload audio, video, animations, simulations, etc.  
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